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Introduction

Course Objectives

NBS Contract Administrator

The objective of this course is to provide delegates with a sound understanding of NBS

Contract Administrator. Upon completion of this course delegates will have a good

knowledge of how to use NBS Contract Administrator, and be able to utilise this information

within their own working environment.

Pre-requisites to the course

It is assumed that delegates are familiar with the Windows operating system environment,

and are comfortable in using a mouse/keyboard.

Assistance after the course

If more help is required then please contact NBS Software Support using the details below:

Address:

Telephone:

Fax:

Email:

Web:

NBS
The Old Post Office
St Nicholas Street

Newcastle upon Tyne
NE1T 1RH

0345 456 9594
01912325714

support@theNBS.com

www.theNBS.com/support



mailto:support@theNBS.com
http://www.thenbs.com/support
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Section 1: Getting Started

Upon completion of this chapter you will be able to:

v

v
v

Open the NBS Contract Administrator software.

Apply a valid licence unlock code where required.

Either create a brand new 'data store’ file to use in association with jobs you
created within NBS Contract Administrator, or use an existing data store that
has already been set up for you

Enter your own company details, ensuring any forms issued from NBS Contract
Administrator show the correct issuer information
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Opening the software

To start using NBS Contract Administrator, double click on the desktop icon.

4
[
WS it

Alternatively go to Start > All Programs > NBS > NBS Contract Administrator.

Licensing NBS Contract Administrator

After installation, NBS Contract Administrator must be licensed before it can be used.

When you attempt to run NBS Contract Administrator for the first time after installation, the
licensing wizard will start to guide you through the steps required to generate a licence code,
store the licence for the software in a specified location and unlock the software.

The following dialog box will appear:

P =

5 Licence Wizard @
Software Subscnpbon Secunty r‘h&
Choose between a new or an existing licence. ;;;

This Productis a subscription service and is protected
against unauthorised usage.

To obtain a Licence touse this Product please ring MBS
Customer Centre between 2am and 5pm Monday to Friday
on 0345 455 9554

Select "new™ to continue the Software Security Wizard - you
willthen be given the opportunity to obtain a new licence.

Alternatively, ifyour organisation has already obtained a
licence, select "Existing™ to usethat one.

@ Mew

i) Existing

= Back ||| Cancel
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If this is the first time that NBS Contract Administrator is being used in your company, select

the New radio button, and then click Next.

=7 Licence Wizard @
New Licence ':"J*\;
Select a location for your new licence. by _ﬁ

Please select a location forthe LicenceStore file.
This file should have read and write permissions for
all users of this software.

ChooselLicence Location:
C:\Program Files (x858\NBS\NBS Contract Administia)

O

| = Back | Mext = || Cancel |

You will then be prompted where to save the licence store file:
To choose a different licence location, click the button indicated, and browse accordingly.

Finally, you will be presented with a request code.

= Licence Wizard (=32
Unlock Licence 7
Unlock a licence for this machine. ';}

Please ring NBS Customer Centre between %am
and Spm Monday to Friday on 0345 458 9554,

They will ask you for the Request Code
shown below.

They will then provide youwith a Licence Unlock Code
which you should enter below. Activatethe code
by pressing the Unlock button

Request Code:
|98888931-8CEDBE2S| |

Unlock Code:
| |

= Back Mext = | | Cancel |
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Telephone NBS Customer Centre on 0345 456 9594 and quote your license request code
shown in the Request Code text box.

In the Unlock Code box, enter the unlock code supplied to you.

Click Unlock and then Finish. A confirmation message similar to the one below will be shown.

-

MBS Licence Manager @

0 ) A standalone licence for ContractAdministrator Standard has been
' successfully installed in the file:
a C:\Program Files (:B8)\NBS\MBS Contract
AdministratorLicences\LicStore.gzd
This licence expires 30/09/2019 and is for 1 user(s)

o Ok

Clicking on ‘'OK’ will then complete the licensing process. NBS Contract Administrator will
then open for normal use.

Data stores within NBS Contract Administrator

Once your software has been licensed, you need to define where the NBS Contract
Administrator data store is held. A data store is the file that contains details regarding all
your jobs, contact information and company details to be used in NBS Contract
Administrator.

Data stores can be either created individually so that each user has their own or they can be
created so that multiple users can access the same jobs if it is to be used across an office
network. Once a network data store has been set up, every person who needs it can link to it
centrally and share the same material.
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Creating a new data store

Once NBS Contract Administrator is opened for the first time after installation, you will need

to create a new data store or locate an existing one.

4] Data store setup wizard “

NBS Contract Administrator data store setup

Choose existing or create a new data store.

Welcome to the NBS Contract Administrator data store setup wizard

ou do not currently have a data store setup for use. NBS Contract Administrator uses a data store, Caftab.cadb, to contain all
company and job detail information. Using the options below, select to either use an existing data store or create a new one.
@' More about data stores

(_) Use an existing data store
NBS Contract Administrator will search your lecal or network drives for an existing data store. Atternatively you can
browse to a data store directly.
@) More about using an existing data store

(@ Create a new data store
Create a new, empty NBS Contract Administrator data store in a location of your choice.

@:‘ More about creating a new data store

Mext = | | Cancel

Using an existing data store

Select the Use an existing data store radio button by clicking on it, and then click on Next.
You will then be asked to locate your data store; the file will be called CAFtab.cadb. Locate
your previously created data store file and click ‘'open’. This will then ensure the software

uses your previously created file.

Examples of where you may already have a previously created data store available would be

if your office already has NBS Contract Administrator installed on other computers.

If this is the case, rather than creating a brand new data store, you could use the same data

store as is used on your existing setup.
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Creating a new data store

Select the Create a new data store button by clicking on it, and then click on Next. You will
then be asked to specify a location for your data store.

If the software is only going to be accessed on one PC, then save the data store file to your
own PC. If the software is going to be used across a network you may want to save the data
store file on a network location. This would be used where more than one person is using the
software at any one time, and everyone would want access to the same company details.

Typically a new data store would be created when this is the first time NBS Contract
Administrator has been installed on any computers in your office, or if you wish to keep the
work carried out on installation of NBS Contract Administrator completely separate from
existing installations.

@ Setting up your data store for multiple users
If you want more than one user to access the same data store and therefore the
same jobs; you should follow these steps:

. Once NBS Contract Administrator has been installed and
licensed, go to one machine and start the software which will
then start the Data store setup wizard.

o Use the option in the Data store setup wizard to Setup a new
data store, you will then be asked to enter a location for the
data store to reside. Ensure that all machines and users have full
access to this folder on the network.

o From every other client PC, you can then use the option in the
Date store setup wizard to 'Use existing data store’; you will
then need to browse to the location that was specified in point
two.

o All versions of NBS Contract Administrator will then use the

same data store.

Setting up your company details

After you have licensed NBS Contract Administrator, and created or located a data store you

will be asked to complete the Issuer Details setup.
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Issuer’'s role: The choices for the first drop down are Employer's Agent, Employer or
Contractor. These are new roles on D&B contracts.

Information in the ‘Postal Address’ is for the address book. Information entered in the ‘Form
Address' area will be printed on all of your forms produced within NBS Contract
Administrator. You can select either ‘Contract Administrator’ or ‘Architect’ and that will
determine whether the user can issue ‘Architects Instruction’ forms or ‘Contract

Administrator Instruction Forms'.

The notes section provides a useful area to store your own internal information about the
company. This could include details such as additional phone numbers etc.

L] Data store setup wizard “

Issuer setup

Fill in the details about your organization.

Company Name* X¥Z Architects Telephone  [0147852369
Fax 0147852369 Notes
Issuer role
For DB contracts Employer's Agent W
For all other contracts | Architect w

Postal Address

Humber The Old Post Office County Tyne and Wear
Street St Nicholas Street Country K
City/Town Newcastle upon Tyne Post code NE1 1RH

Form Address

e [The Oid Post Office, St f his address will be inserted on
Line 2 Newcastle upon Tyne, N relevant form headers

I

« Back Finish | | Cancel
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Exercise

1. Select Tools > Edit Issuer Details.
2. Amend the issuer’s details by adding two contacts and selecting Employer as
another role.
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Section 2: User Interface

Upon completion of this section you will be able to:

Understand the NBS Contract Administrator user interface and terminology.
Understand the different categories of job in NBS Contract Administrator.
Navigate through NBS Guidance and Support.

Manage and maintain the address book.

ANEANER NN
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User Interface

The screen layout within NBS Contract Administrator has been designed to provide a clear,

intuitive user interface, with clearly marked areas from which to obtain guidance on forms

being used.

Once a form of contract has been decided upon for your job, users can only access forms that
are associated with that contract. With multiple methods of working with forms, users can
quickly become comfortable and familiar with the interface - enabling them to use the

software easily and simply.

The NBS Contract Administrator screen is broken down into three main areas:

£+) Demos - NBS Contract Administrator - a

Demos lemos
F¥I  All demos E X o

®% crest=anew demo Ref. Title Date modified Form of contract
23/10/2017 14:35  SBC 16
23102017 14:35 DB 16

or Works 23/10/2017 1435 MW 16
23/10/2017 14:35 1CD 16

NBS Guidance

% Create new demo in progress A_16_15 Centre
v_06_17  Clare

OL/13/03  Marin
AUJ27/09  Language Laboratories

Support ||

< > &0

Find an answer
QL

Howffo Troubleshoothig

Ask s meorB

o ContactfiBS Customer Service

L

1. Job browser
2. Displays all jobs in current view
3. NBS Guidance and Support

Using jobs in NBS Contract Administrator

In order to start administering forms within NBS Contract Administrator, an associated job

needs to be created first.

The job contains details on where the work is being carried out, the various team members
responsible for carrying the work out, the form of contract to be used for this job as well as
the contract sum involved. It also details the contract administration forms that have been

issued in association with the work being carried out.
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By using ‘jobs’, it enables information to be easily organised and quickly accessed. All the
associated details for a particular job will be kept together within one place for that ‘job’ - ata
glance users can see what form of contract is being used, which forms have already been
issued and when, and which forms are still awaiting issue.

The left hand side panel is the job browser and this enables users to create a new job, or create
ajobin progress, as well as browse all current jobs. The central pane displays all jobs that are
associated with the selected type of job. Users can view the job title, its reference number

and the form of contract being used for that job.

Categories of job

There are three different types of job status within NBS Contract Administrator, these are:
Current jobs

This displays information on jobs that are currently ongoing. From here, users can access

forms that have been issued or are in a draft state and they can also add new forms to a job.

They can also view details on all the different team members involved with the job and any
revised contract sums.

Archived Jobs

NBS Contract Administrator allows users to set a job to be ‘Archived’. This might be done if
a job has been completed, or if the job is currently on hold. By setting the job to be archived
it will no longer appear in the list of current jobs, and so make it easier to organise jobs.

Demo Jobs

NBS Contract Administrator also comes with example demonstration jobs. These are
intended to give users an opportunity to look at how jobs can be set up within NBS Contract
Administrator. Users can view, issue, recall and delete forms within these demo jobs without

impacting on their own ‘real’ jobs.
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To alternate between the three different categories of job status, click on the ‘View' drop
down menu and select accordingly:

o

File | YView | Jeb  Tools Help

Alternating between different types of job status

Jobs Mavigator Pane

oAl Guidance Pane

2% o Search MBS Guidance »
a_'l'L CF lobs

Jobs Demos

e 10 Archive

Q'e Team

E Forms (0}

L= Cost tracking

Opening a job

To open a job within NBS Contract Administrator, double click on the job title. The central
work area will then alter to show details of all forms used so far within that job. The left hand
task bar will then change to show a reference library, from where new forms specific to that
job can be added.

Users can also access details for this job. This includes the team membersinvolved in the job,
as well as any revised contract sum details.

Guidance and support

NBS Contract Administrator includes information on how to carry out tasks within the
software, as well as guidance on administering the contracts themselves. All of this
information is written by industry experts at NBS.

Having this guidance and support at your disposal ensures that the use of the software itself
is trouble-free. Having expert-written guidance also ensures that any user who may be
unfamiliar with a particular contract administration form can read precisely what the form is
used for, understand how it is to be completed and has clear definitions on what each term
used in that form means.
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The guidance can also be searched by keyword and browsed separately, clicking on the
search icon.

Guidance

Contracts covered by our guidance A

Standard contracts

» JCT Standard Building Contract 2005

» JCT Standard Building Contract 2011
(SBC11

» JCT Standard Building Contract 2016

(SBC16

All guidance is listed in sections.

This guidance synchronises with the content, to show information appropriate to the section
that you are working in.

There is also comprehensive software support available within NBS Contract Administrator.
The information here is designed to provide assistance in using the software and stay
synchronised with the tasks that the user is performing.

< > oo

Find an answer

@ A

How To Troubleshooting
Ask someone
+« Contact NES Customer Semvice

s Search the NBS Software Support knowledage

« Booktraining with NES Customer Suppor
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Searching Guidance and support for information

Both the Guidance and support sections are designed to stay in synchronisation with the tasks

the user is carrying out, ensuring that only information relevant to the task in hand is

displayed.

Users can search both these areas of the software at any point for information. Searching is

performed by selecting the magnifying glass icon.

Searching Guidance

Once the Guidance search is open, and you open the links on the Contents tab on the left,

the screen will look like this (it will default to the contract Guidance you have currently

selected in your job, in this case the SBC16 contract is selected):

EX SBC16 Guidance
2 ol
Hide Refresh  Home Options

Contents | Search

2] Job details

2] Job team

2] Advance Payment

2] Sectional Completion
& Administration forms

= ([ How

2] Job details

2] Job team

2] Sectional Completion

@ Administration forms

- o

=0 sncm Home
= [ Why

Contract Administration Guidance »

for SBC16 contracts

Why?

Only guidance relevant to the selected form of contract will be shown. Users can browse the

guidance by either content type, or by searching for key words within the guidance.
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Assistance in using NBS Contract Administrator

NBS Contract Administrator provides detailed help in using the software. If users are unsure
on how to carry out a particular task in the software, the Support section can be consulted.

The Software Support section is broken down into two areas - ‘How To' and
‘Troubleshooting’.  Accessing ‘How To' gives users access to the NBS Contract
Administrator help files, ‘Troubleshooting’ takes users to the NBS Subscribers website. The
website provides access to knowledge base articles and videos designed specifically for NBS
Contract Administrator. Please consult with the appendices for a more detailed explanation
on how to use the search facility within the 'How To' section.

As well as software support within NBS Contract Administrator, you also have access to our
unrivalled software support team, who will be happy to offer assistance with any query you
may have. They can be reached at NBS on 0345 456 9594.

Managing the address book

NBS Contract Administrator allows you to store companies and their associated contacts in
an address book for use on all jobs. This is beneficial as once a company’s details have been
entered, they will always be available for use in any future jobs you undertake, and so saves
you time in having to re-enter the same information numerous times.

If you have a local data store you will only see company details that you have added, if
however you have NBS Contract Administrator set to work across a network, other NBS

Contract Administrator users can also have access to companies listed here.

To access the address book, click on Tools > Address Book.
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This is your global address book. Changes made here will be applied to affected forms
when they are next opened for editing.

Use the buttons below the company list to:
« add new companies;
» edit the details of existing companies; and

- Anlatn mmmnnanias

-@ More about managing vour address book

Company name/rale

Celtic College

Cymric Construction Lid

lvor Barch Associates

MBS

Meville Construction Lid

Peace Haven Developments Pl
Weathervain Builders

‘Weston Morth

XYZ Architects

| |

| Mew company | | Edit company | | Delete company

Adding companies to the address book

To add a company/individual to your company, select the New Company button at the
bottom of the window. The New Company window will then be displayed.

| save || cose || savesCose || Hep |

Company Name |New Company | Telephone l:l
| [N —

les

lssuer

Employer

Contractor

Sub-Contractor

Clerk of Works

M&E Consultant

Planning Supervisor / COM Coordinator

coty [ ] Quantity Surveyor
Country l:l Structural Enginesr
|| Employer's Agent
] S
Editroles

Notes

Postal Address

000000000 8

L

Form Address

Line 1 |

This address will be inserted on

Line 2 | relevant form headers

Line 3 |

Contacts

MName Position Email Address Telephone Mumber

#*
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Enter the details for company name and address by clicking in the relevant area and
completing information as required.

Select the ‘Roles’ boxes to signify the nature of the business. Companies can have multiple
roles as well as different roles on individual projects.

The Companies and Contacts created here can then be used to complete other form areas,
such as the distribution lists and Job details. In turn, this will help save you time in the future
when setting up new jobs etc.

Adding Company Contacts

To add a contact within the company, click into first row within ‘Contacts’ marked ‘Name' and
enter the required information. While you are entering contact details, a blank contact space
will appear below in case you wish to add another entry.

Clicking the ‘Help’ button at the top of the ‘'New Company’ window will also display help in
the right hand side panel, instructing the user what information needs to be entered in order
to set up a new company.

Editing Company Details
Company Details are edited within your address book. You may need to do this if your own

company changes address, or new members of staff need to be added. Similarly your
customers may also need their details updating.

This can be accessed via Tools > Address Book. Either double click on the name of the
company you wish to edit, or click on the company name, then click the Edit Company
button.

[+ Address Book “

This is your global address book. Changes made here will be applied to affected forms
when they are next opened for editing.

Use the buttons below the company list to:
= add new companies;

= edit the details of existing companies; and
- Anlata mmmnnae e

\@ More about managing your address book

Company name/ role i

- Contractor

CelticCollege

Cymric Construction Lid

Ivor Barch Associates

NBS

Neville Construction Lid

Peace Haven Developments Plc
- Weathervain Builders

- Weston Morth

- XYL Architects

J | o

| New company | | Edit company | | Delete company

[ - [
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Company details will then appear, and can be edited accordingly.

| Save || Close || Save & Close || Help |

Company Name |AEC Inc.

| Telephone [123654789

Email |www.ahc.cu.uk

o

Postal Address

Number |1

Street |High Street

City/Town |Newca,stle upon Tyne

Form Address
Line 1 |1, High Street |

Line 2 |Newca.5.tle upon Tyne, NE4 8TH |

Line 3 |UK |

Contacts
Mame Pasition
Fred Bloggs MD

County |T)rne and Wear

Country |UK

Post code |NE4 &TH

This address wil be inserted on
relevant form headers

Email Address
Fred.bloggsi@aBC.com

Removing a role from a company

Roles

[] lzsuer

[] Employer

[] Sub-Contractor

[] Clerk of Works

[] M&E Consultant

|:| Planning Supervisor / COM Coordinator

[] @uantity Surveyer
[] structural Engineer
[] Employer's Agent

Edit roles |

Hotes

Telephone Number
963258741

You may want to remove a specific role from a company, but not wish to delete the company

details. To do so, open the company details for editing (see above). When the company

details are open, deselect the role from the company details by clicking on the appropriate

box.
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Exercise

Open the Address Book and create two companies with the following details:

Company Name: The Goode Building Company
Telephone: 0191112 334
Facsimile: 0191 433 211
Postal Address: 10 The High Street, Newcastle Upon Tyne, Tyne and Wear, NE2
S5JH
Form Address:10 The High Street, Newcastle Upon Tyne, Tyne and Wear, NE2 5JH
Roles: Clerk of Works, Quantity Surveyor
Contacts:
o Mr J Smith is the Principal architect of the company; he has no direct line
but can be reached on jsmith@goodebuildingco.co.uk
o Oscar Browne is a quantity surveyor, his direct line is 0191 112 340 with an
email address of obrowne@goodebuildingco.co.uk
o Finally Austin Bailey is the Clerk of Works at the Goode Building Company,
there are no direct contact details for him at this time.
Company Name: AJ Architects
Telephone: 0191 489 76 66
Postal Address: 65 Ripley Gardens, Gateshead, Tyne and Wear, NE3 8FY
Form Address: Centenary House, Ripley Gardens, Gateshead, Tyne and Wear,
NE3 8FY
Roles: M&E Consultant
Contacts: Martin Johnson is the M&E Consultant at AJ Architects. His direct
number is 0191 489 76 80. He can also be emailed on
Martin.Johnson@AJArchitects.com

Did you notice?

For AJ Architects, the Postal Address and Form Address are slightly different. It may

follow that the address shown internally to yourselves may be different from the address

that is displayed on forms you generate with NBS Contract Administrator.




Section 3: Starting a new job

Upon completion of this section you will be able to:

ANEANEA NN

Create a brand new job in NBS Contract Administrator.

Specify the various people involved in the job you are creating.

Manage your own list of roles that exist within a company.
Edit company details as required.

Starting a new job




Starting a new job

First you need to make sure you are on the Jobs page. Select View then Jobs.

File | View | Job Tools Help
Jobs ZI Mavigator Pane Jobs
E—' A|Z| Guidance Pane > f- ar
f‘i o Search NBS Guidance  »
°_-1:- Cr Jobs |

Demos

Archive

There are three ways to create a new job within NBS Contract Administrator:

The following screenshot shows three different areas from which a new job can be started.
Selecting any of these methods will result in the Job Details form being displayed.

File J View Job Tools Help

Jobs ’ Jobs

B Alljobs ] & R
t Create a new ju:ul:u)

'i- Create new job in progress

WVa
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The new job then opens and the editing window in the centre will prompt you to add details
about the job from the contract.

4] Job Details - New job - NBS Contract Admini o - a
File View Job Tools Help
Jobs Contract Administrator*
B Al jobs i F ¢ > @ .o %
} crestea e PR — ~| JOB DETAILS A
%. Create new job in progress
oo Fields with a ( = ) are required Sase date

B 300 Detais > “Form of coniract w v| *debfte
8 Team The base date ofthe job as stated in the
Contract revision he contract, usually sither the tender return

B Forms ()
I Cost tracking date or one slightly earlier. Although not
defined in the contract, itis the date from
Options which the currency of certain documents is

The following options are specific to this job enly. To change the default options for new jobs, please use the _
options menu undar Tools > Options, or consutt ths help documentation

< > oo

Currency: £ Pounds v
Form logo: RIBA crest v JOB DETAILS A~
Output location: C:Wsersifletchek\Desktop\Outputh JOB EDITOR
Works MBS Contract Administrator stores
Description: Address: | ] information an jobs in order to produce

I ] accurate financial reports and to ensure

[ ] ihat consistent job descriptions and

are printed on contract forms.

oo ] [ J Below are descriptions of all the figlds

Please accurately complete all the job

fields before adding any contract
Contract Conditions.
e administration forms;

* Employer:
mplover Employer Name hd Total estimated additons: 3 0.00 Mandatory field
SEIETE Contractor Name andatory fields
Total estimated omissions: 3 0.00
Add a new MW form Contract sum, £ Total Advance Payment: = 0.00 Before a job can be saved the following
fields must be completed:
B Architects/Contract Administrators Instruction Advance payment £ Amount certified to date: £ 0.00 P
B interim certficate -
B noncompletion contract daied: B Revised estimated contract sum: & 0.00 + Jobitle
Bl Practical Completion Cone s = 8- + Form of contract
B certificate of Making Good Base date: [Ehd Defects liabiity end date: - « Jobreference
B Final Certificate Date of possession B Amended completion date: - « Employer
Bl Adjustment of Completion Date
Qriginal completion gate. [Ehd

« Contractor

Rectification period [ Honths -

Rate of damages: £ per [pay " In addition the form of contract field will be
o pra-rata thersto locked once a draft form has been added to

Retention Bond o ajob -

Full retention: [ o= v

You are up to dats ~ | Your subscription wil expire on 28 February 2018

In order to begin administering forms for a job, there is specific information that needs to be
entered:

Form of Contract

This is set at MW (Minor Works) by default. This identifies the form of contract being used on
the job. The form of contract selected here will determine the Contract Administrator forms

the user can have access to.

Once forms are issued, the form of contract is then locked. By doing this, it then ensures that
only forms associated with that type of contract are issued - i.e. if you opt to use JCT IFC 2016
as the form of contract, you cannot issue a form found in the Minor Works Building Contract.

Contract revision

2005, 2011, or 2016 versions

Job Title

A brief description of the work to be undertaken.
Job Reference

Each job within NBS Contract Administrator must have a unique short reference to identify

it. This may be the job number, file reference or other identifier within your office.




This reference is also used to construct the file names of all the automatically generated PDF
documents of issued forms. For example, the 2nd Architects Instruction to be issued on job
reference IBA_04_20 will be named IBA_04_20_Architectinstruction_2.pdf

Options

You have options to choose the form of currency, the form logo (which can be either RIBA
Crest, Custom logo which you can import from your files, or none at all), and the Output
location which is defaulted to the Output folder on your machine or network.

Contract Conditions

Before you can start issuing forms within NBS Contract Administrator, you need to create a

new job.

This will prompt you to fill in the Job Details, - including the Job name and location, the parties
to the contract, dates, contract sum, retention percentages and suchlike.

You do this once only, and the software will then transfer the details automatically when
producing the forms and certificates for that job. The details outlined below are what form

the conditions of the job contract.
Employer Details:

Clicking on the ‘Employer Name' box displays a drop down box containing companies as
created within the Address Book. Clicking on a name here sets this company to be the

employer.

Contract Conditions

* Employer Employer Name] v
* Contractor.
XY Z Architects
Contract sum: £ IABC Inc.

Contractor Details:

Similar to ‘Employer Details’ - this enables the user to select from the Address Book and
identify who the Contractor is going to be for the job.

Contract Conditions

+ Employer: X¥Z Architects s 'i:]‘ Tol

+ Contractor: ABC Inc. hl Tol

Contract sum: £ | IZI.IIIEIl mul

Advance payment: £ | An

=
=]
=
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Once selected the icon to the right of these boxes become active and you can select the link

to amend the contact information.

@ Please Note

Progress can only be made on a job once the Employer and Contractor details
have been provided. Until these details have been entered, no forms can be

produced.

Contract Sum

The figure entered here is for the total cost of work to be carried out for the job. Once the job
is underway, this field cannot be altered. Anything that results in the Contract Sum varying
(such as the issuing of an Architects Instruction) is taken care of by NBS Contract
Administrator, with the revised contract sum calculated automatically.

The Works
Used to specify where the work is to be carried out.

The user can also state on which date the contract has been dated etc. as well as decide what
logo is to be used on any forms generated within NBS Contract Administrator.

The Team Tab

The Team tab allows users to add team members from the various companies in the address
book to your job. Companies entered as Employers and Contractors on the job details tab are
entered into the job team automatically.

To add additional members, click on the Add Member button and then select the company
role from the list.

Assigning roles and companies to the team tab

Once a role has been assigned to the team tab, the company who are performing that role
needs to be selected. This is done from the ‘Company name' button. Clicking here will
display a list of all the companies currently contained in the Address Book.

To assign an individual within that company to the specific role, click on the 'Allocated Staff’
button in the ‘Contact’ column to select the contact within that company who will be
responsible for the selected role.




Please note that the details entered on the team tab are used to generate the distribution lists
and associated transmittal sheets for all issued contract administration forms.
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Creating your own Roles within a company

NBS Contract Administrator comes with a pre-defined list of company roles. However, you

can personalize this list to suit the needs of your office by adding your own roles. Go to Tools
> Roles.

File View Job | Teols | Help
Jobs Spell Check... tract Ad
f] All jobs Spell Check Options..
3 Create a new job Options... h—I:Details =
3":'- Create new job in Address Book...
Fields witt
Jobs Distribution List...
W, 300 Details Instruction Types.. * Form of ot
88 Team Roles... *Contract r
ﬁ] Forms {0)
= Cost tracking Edit Issuer Details...
Licence 5tatus...
Options
Check For Updates S
e follow
I | options m

The Roles window will appear.

Currentroles:
lssuer |
Employer
Contractor | Add role | | Delete role |
Sub-Contractor B
Clerk of Works @ More about roles
WM&E Consultant

Planning Supervisor / COM Coordinator
Quantity Surveyor

Structural Engineer
Employers Agent
Architect

Principal Designer

Cancel




Adding Roles

To add a new role, enter the name of the new role in the Role box and then click on the Add
Role button. This will add your new role to the Current roles list.

Deleting Roles

Please note that you cannot delete the NBS Contract Administrator pre-defined roles. To
delete a user defined role select the role in the Current Roles list and then click on the Delete
Role button, you will be asked to confirm your decision as this may affect any companies
which have had this role assigned to them.

Editing Company details

If alterations need to be made to company details, such as a new role needs assigning, or a
new staff member has joined a company then such changes can be made from here.

Clickthe ™ icon to edit company details

Team - New job *
H & 3]

Job Details | Team

lssuer Company Contact

Architect v | X¥ZArchitects Allocated Staff W (:J
Role Company Contact

Employer X Z Architects W Allocated Staff W | Ii:il
Contractor ABC Inc. W Allocated Staff W | Ii:l
Add member | Edit roles

Clicking on the highlighted icon next to any of the rows as shown above will then display the
company details form. From here users can make adjustments as required.
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Further tabs available to the user

Depending on the form of contract used, the user will have access to different tabs along the

top of the job screen.

An example of this would be ‘Sectional Completion’. This is only available if Intermediate
and Standard forms of contract are used. The sectional completion tab is used to record
details of phases of work (sections) during your job, if they’'re applicable. If you do not need

to add any sections, ensure that the No sections included button is selected.

Sectional Completion - abc123 The Fox And Hounds
H & %]

Job Details | Team | Sectional Completion

Fields with a ( * ) are required
(@) No sections included

) Include sections Add section

To add sections, ensure that the Include Sections button is selected and click on the Add
section button. A section will appear for you to complete, by clicking in the boxes and
completing the information required. You can add as many sections as required throughout
the duration of the job. However, once a form is issued you will no longer be able to remove
any previously added sections. Section details must be entered in the Sectional Completion
tab before they will be available in the section drop down lists on any of the forms that deal

with sections.




Exercise

1. Create a new Job using one of the three icons shown earlier.

2. Complete the Job details form, ensuring that MWO05 is used as the form of
contract.

3. On the Team tab, ensure that the clerk of works you created earlier is appointed,
and that an email address of abailey@goodebuildingcompany.co.uk is entered.

4. You need to have a landscape architect within the list of team members. Create
a brand new company, with contacts, and then create a brand new role of
landscape architect. Add this new company and contact to your list of team
members.

5. On the job details tab, set an advanced payment of £750.
Did you notice?
Were you able to provide the advanced payment of £750? If not, why?

Using the guidance within the software, find out why you may have been prevented

from giving an advanced payment.




Working with
forms

Section 4: Working with forms

Upon completion of this section you will be able to:

Be familiar with the various methods of adding forms to your job.

Understand how to use NBS Contract Administrator in completing these forms.
Be able to issue a form from within NBS Contract Administrator.

Be able to amend a distribution list to ensure the correct people receive as many
copies of the form as they require.

Be able to recall a form that requires amendment.

AN NEANEAN

<
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Adding a Form to your job

Once a job has been created, NBS Contract Administrator only allows access to the form
library appropriate for that form of contract.

There are a number of different methods for adding a form to your job:
Via the Form icon in the Forms List view

Clicking on the icon indicated displays a list of available forms. Once a form is selected, a draft
copy will then be added to the job. The job details panel will also update to show a copy of
the form has been added to the job, the form will then open in the centre of the screen.

Forms - abc123 Fox and Hounds - NBS (

File View Job Tools

Help

Jobs
B Alljobs
% Create anew job
°_a: Create new job in progress

abc123 Fox and Hounds

a-

ms - abc123 Fox and Hounds

rchitects/Contract Administrators Instruction
Interim Certificate

MNeon-Completion

M Job Details Practical Completion
88 Team Certificate of Making Good
Bl Forms @ Final Certificate

1= Cost tracking

Adjustment of Completion Date

urrently no forms in t

Via the ‘Job’ drop down menu

Forms can also be added via the ‘Job’ drop down menu at the top of the NBS Contract

Administrator screen. Again, clicking here displays the library of forms available for the type

of contract selected for the job.

Selecting a form here will add a draft copy of the form to the job, and open the form in the

centre of the screen.

L Forms - abc123 Fox and Hounds - NBS
File View [ Job | Tools Help
Jobs | Add Farm 4 Architects/Contract Administrators Instruction
E Alljobs Open Form Interim Certificate
Close Form

an
__F Createan:

°_e" Create nes

Recall Last Issued Form

Drelete Form

Men-Completion
Practical Completion
Certificate of Making Good

abc123 Fox an Is in
Lg Job Detzils Add Team Member Final Certificate

88 Team Print Preview Adjustment of Completion Date

E Farms (0)

1= Cost tracki Edit Instruction ltems Cost Tracking

Job Cost Tracking Report
Job Instructions Report
Job Activity Report

Job Valuation and Certificates Report

Job Financial Statement
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Using the form library

Once a form of contract has been selected, the forms available for the job will be displayed in
the bottom left hand screen:

Right-clicking on the mouse on any of the forms will display the ‘Add to..." dialog box. Clicking
here will then add a draft copy of the form to the job, and display the form in the centre of the

Add a new ICD form
Architects /Contract Admi= i

Interim Certificate Add to New job
Statement of Reimbursement

screen.

Partial Possession by the Employer
Mon-Completion

Practical Completion

Section Completion

Certificate of Making Good

Final Certificate

Adjustment of Completion Date

Iy oy iy iy i oy i ) i ey

Alternatively, users can also hold the left mouse button down on the form they wish to add,
and drag the mouse pointer to either the left hand task bar or to the central screen - this will
then add a draft copy of the form to your job.

Another route to add a form is by selecting one from the list and clicking on the text above

that says '‘Add a new [contract] form'. So for the example above, click on ‘Add a new ICD form'.

Once the first form is added to a job, certain fields in the job details such as the

form of contract are ‘locked’ and it will no longer be possible to edit them.

Completing form details

Once a form has been added to a job, a draft copy of that form will then open in the centre of
the screen.

The editors have been designed to reflect the way that the forms appear when printed.
Opening a form for editing will display the form in the central work area.

Various tools have been put in place to make form editing as comprehensive and easy as
possible, such as selection fields, calendar fields, radio buttons, linked fields and text boxes.
Descriptions and examples of how these are completed can be found in the appendices
section.
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Working with Instruction Forms

Architects/Contract Administrator Instructions allow you to add as many or as few

instructions items as required.

Architects/Contract Administrators Instruction 1 - Draft
- P HEARIV = | BRA|B I U

Created date; 22 September 2017
Contractor:  ABC Inc.

address: 1, High Street Shest  10fx
Mewcastle upon Tyne, NE1
1TH

‘Works: Pub Extension including new kitchen and toilets

situated at: 10 Main Street
Durham
Co. Durham
DRAFT
Under the terms of the IcD Building contract dated 22 September 2017 Show costs on printed form W

Office use: Approximate costs

£ omit £ add
Title 0.00 0.00
Description
Type (for Cost Tracking Report) W

Architects/Contract Administrators Instruction 1 - Draft

R FanRay =(4a@(B 7 U

To add an instruction item, click on the new item button found in the toolbar at the top of the

Al form.
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This will add a blank item for you to complete. Number them consecutively and consistently.
Do not use the anticipated number of the Instructioni.e. 1.1, 1.2 etc. as this may end up not

being the order of issued forms

Works: Pub Extension including new kitchen and toilets
situated at: 10 Main Street
Durham
Co. Durham
DRAFT
Under the terms of the ICo Building contract dated 22 September 2017 Show costs on printed form W
Office use: Approximate costs
£ omit £ add
tle 0.00 0.00
Description
Type (for Cost Tracking Report) W
Title 0.00 0.00
Description
Type (for Cozt Trecking Report) W

Click on the Type (for cost tracking) drop down button and select an instruction type from the
list. Item types allow you to attribute costs to any of the types on the list and to create a

financial report based on this information.

In the area above the Item type, add more detail about the instruction by clicking the box and
then typing your information. This information can be copied and pasted from elsewhere, i.e.

an email.

To issue the form click on the icon at the top of the centre panel as shown below.

Architects/Contract Administrators Instruction 1 - Draft”

-d & &RE)E Y = B 7 U
Created date: 22 Sep
Contractor:  ABC Inc.
address. 1, High Street Sheet 1o0fx

Mewcastle upon Tyne, ME1
1TH
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As soon as you select to issue the first instruction you are given the following warning which
indicates that certain figures and team member’s details will become locked and will no longer
be able to be edited. This is why one should be careful to add all the confirmed details into the
job at the start.

MNBS Contract Administrator “

Issuing a form will automatically save all your changes.
Issued forms can be changed back to draft status using Recall Last

Issued Form.
Please note, this is only available for the last issued form on each job.

Issuing a Contract Administration Form will lock the following fields in
the job details editorn:

- Employer

- Contractor

- Form of contract

- Job reference

- Currency

- Contract sum

- Full retention percentage

- Half retention percentage

Do you want to continue?

Click "Yes' and you will be asked to choose an issue reason from the value list. This will help

filter the instructions in the instruction reports later.

o NBS Contract Administrator H

Please enter an issue reason.

E.g. For Payment, For Construction, For Information.

This infermation will be included on the accompanying
transmittal sheet.

one; vi
[ | Dont show this message sgain




NBS Create Training Guide

The software will then confirm that PDF files of both the instruction and an accompanying
transmittal sheet (for your records and to accompany your fax if you use them), and will tell

you where they have been saved and ask you whether you would like to open the file.

MBS Contract Administrator ﬂ

The certificate(s) and its accompanying transrittal sheet has been
exported to pdf files,

File location:
ChUsersifletchelh Desktoph Output\023mka\CAFs

File names:
1. 0253mko_Instruction_1.pdf
2, 025mko_Instruction_1_T.pdf

Do you want to open the saved files?

es Mo

The PDF files can then be emailed as attachments, saved to your records and printed if
required. The instruction then becomes locked and can no longer be edited, however, itis
still possible to print off copies and create other PDF files. This is the transmittal sheet:

Transmittal sheet for: Pub Extension including new kitchen and toilets

Practice name: XYZ Architects Job ref: abc123
Practice address: The Old Post Office, St Nicholas Street Issue date: 22 September 2017
Newcastle upon Tyne, NE1 1RH
UK
Form code Form title Form number

Architects/Contract Administrators Instruction 1

Issued to:

Name No. of copies
Employer Newcastle Breweries 1
Contractor ABC Inc. 2

File Copy XYZ Architects 1
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The instruction will show the figures by default. It will also have the Draft number and the
Issue number as these may be different depending on the order of issue.

Architect's /
Contract
- '
Issued by: XYZ Architects Admmu:‘:trator S
Instruction
address: The Old Post Office, St Nicholas Street Job reference: abc123
Newcastle upon Tyne, NE1 1RH
UK Instruction no: 1
Employer: Newcastle Breweries Draftno: D1
address: 5, Bath Lane
Newcastle upon Tyne, NE4 6TH
UK Sheet: 1 of 1
Contractor: ABC Inc.
address: 1, High Street
Newcastle upon Tyne, NE1 1TH
UK
Works: Pub Extension including new kitchen and toilets
situated at: 10 Main Street
Durham
Co. Durham
Under the terms of the ICD Building Contract dated 22 September 2017
Office use: Approximate costs
£ omit £ add
1 UPGRADE TO FRIDGE FREEZER 0.00 2,000.00

You can still print versions with or without costs using the hide costs option.

Hide costs on printed form W

Show costs on printed form
Hide costs on printed form

£ omit £ add

0.00 2,000.00
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Once the form has been issued, amounts entered into either the ‘'omit’ or ‘add’ columns will
update the Revised Estimated Contract Sum amount found under the job details section.

Contract Conditions
Current Status

SnrEe SR T )  Total estimated additions: £ 10,000.00
Contractor: uHERIE ) Total estimated omissions: £ 1,000.00
Contract sum: r| .‘-c.ccc.cc| Total Advance Payment: £ 0.00
Advance payment: £ | 0.00 Amount certﬁed to date: % o.00
Coeclae 22 September 2017 B- Revised estimated contract sum: £ 79,000.00
Commission date: 08 September 2017 [ERg

Base date: 22 September 2017 E~ m =

Date of possession: 29 September 2017 E~ Amended completion date:

Original completion date: |01 January 2018 [ERg

Rectification period: DI Menths v
Rate of damages: £ PET | Day ]

or pro-rata thereto
Retention Bond: O

Full retention: I:I%
Retention post practical completion: %

In the list of forms the icons look like this:

Forms - abe123 The Fox And Hounds

a-@laRalk

Form Title Mumber Status Date created
Architects/Contract Administrators I... 2 ] 22{09/2017
Architects/Contract Administrators I.. 1 22/09/2017

The orange square indicates a Draft form, the white triangle indicates an issued form that
can still be recalled. You can recall the last issued form on any project by selecting this
button:

Forms - abc123 The Fox And Hounds

B-&0Q

Form Title Number Status Date created
Architects/Contract Ad sL. 2 ] 22{09/2017
Architects/Contract Administrators I... 1 22f0s/2017

A Grey circle will indicate that the form has been issued and no longer can be recalled.
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You should remove any PDF copies saved as these may give inaccurate reports. The

software will warn that you may need to do this.

[+ Recall report “

PDF copies and Job reports

WWhen this form was issued, a PDF copy was generated in the output directory. Once the form is
recalled, this PDF will no longer be an accurate record of the form and should be deleted. In addition,
any reports generated since this form was issued may now be out of date.

POF copy location: C:\Users\fletchek\Desktop\Outputi025mko

L ] Are you sure you want to recal issued certificate number: 1. Architects/Contract
\) Administrators Instruction now?

Removing instructions that are no longer required

Clicking into the item description will turn the item grey to indicate it is selected.

2 NEW SOUND SYSTEM 0.00 8.000.00
Bose sound kit arranged by client

None LY
3 REMOVE QLD JUKE BOX 1.000.00 0.00
Return to stores
L

Locze equipment

Clicking here will delete the selected instruction item.

Architects/Contract Administrators Instruction 1 - Draft”
=g = = "5'"3:'\ B J U
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Selection fields

=

MNone -

Selection fields are marked with a drop down arrow button. Clicking on the button will show

the available options, as shown below. Just click on the one to be used.

(=]
i}

=]

FC zums
Frovizions! sums
Demaolition efc.
Substructure
Supersiruciure
Intemal finizhes
Looze equipment
Extemsl zenices
ntemsl zenices
Extemal woriz
Client vanstions
Freliminsnes
Mizcellsneous

Defining your own instruction types

Earlier in this guide we looked at using Instruction Forms. These forms include an ‘Instruction
type’ and these are used to categorize Architects and Contract Administrators Instruction

items.

Categorizing into different types allows these forms to be subsequently grouped by
Instruction type in the Job Financial Statement report discussed in section six.

Whilst NBS Contract Administrator comes with a series of pre-defined Instruction types, you

are able to add new types to suit the needs of your company.
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LE] Instruction Types “
Current instruction types: Instruction type:
PC sums |
Provigional sums
Demolition etc. | Add type | | Delete type |
Substructure )
Superstructure @ More about instruction tvpes
Internal finishes
Loose equipment
External services
Internal services
External works
Client variations
Preliminaries
Miscellaneocus
| oK | | Cancel |

To add custom instruction types, go to Tools > Instruction Types, the Instruction Types
window will appear.

Adding an instruction type

To add a new instruction type, enter the name of the new instruction type in the Instruction
Type box and then click on the Add type button. This will add your new instruction type to
the Current instruction types list.

Deleting an instruction type

Please note that you cannot delete the NBS Contract Administrator pre-defined Instruction
types. To delete a user defined type select the user type in the Current Instruction types list
and then click on the Delete type button - you will be asked to confirm your decision as this
may affect instruction items which have had this instruction type assigned.

If an instruction type is deleted, then any instruction types that have been issued, or are in a
draft status, and did have the deleted type associated with them, will no longer have an
instruction type associated with them.

Spell check

When you have completed your instructions, you may want to use the spell check facility
which is available within NBS Contract Administrator.

Architects/Contract Administrators Instruction 2 - Draft
@& LB ‘"3""—‘:-: L EBa@m(B I U

v

Clicking the icon launches the Spell Check.
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Fields populated on issue

Certain fields in your forms will remain blank until the forms are issued. Fields such as Issue

date and final date for payment will not be entered until your form has been issued.

(%]
y
et Interim Certificate
Serial no:  SNUMAQ0001
Job reference:  StampEx Refurb
Certificate no: 1
Date of valuation: 09 Octeber 2017 I
Issue date: 09 October 2017
Due date: 23 October 2017
The final dzate for payment is
14 dzys from the due dafe.
ed under the terms of the

The serial number is also automatically entered when a form is issued. SNUM is the default
prefix, however this can be changed to reflect a specific requirement in the Tools > Options

area.

Setup || Form logo ||Fi|ELDCEtiDI‘I5|| Display |

Serial Number Prefix:

This prefix can be used to uniquely identify that a form eriginated in your office, or to
distinguish between forms izsued from branch offices if applicable.

General Ontinns:

Final certificate

Once the final certificate is issued, it is not possible to add or issue any further forms in your

job.
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Issuing a Form

Whenever any form is issued within NBS Contract Administrator, a PDF copy of the form is
automatically generated, along with a transmittal sheet. The transmittal sheet is used to
indicate which forms have been produced, and how many copies of each form the intended

recipients should receive. The ‘Issued to’ area is populated from the Distribution List.

Once the PDF files have been created the user will be given the location where these files can
be found, as well as an opportunity to open and view the PDF files.

Distribution Lists

It is good working practice to check the Distribution List. To do this, click on the tab marked
‘Distribution List’. If you wish to remove someone from the distribution list and therefore
the transmittal sheet, uncheck the check box in the Send column. You can also amend the
number of copies that are to be sent to each contact by clicking in the Copy field and typing
in a new number.

Amount of Contract SumiTender Price £ 25,000.00
+ Approximate value of previous issued Instructions £ 0.00
Sub-total £ 25,000.00
+ Approximate value of this Instruction £ -250.00
T

T S T T = h
Distribution [ Contractor | 3| [ Quantity Surveyor O Clerk of Works m}
[¥] Employer | 1| [0 structural Engineer O O other
[ Principal Designer [0 M&E Consultant O [l Filz | 1]
.
m for MW/MWE ® RIBA Publishing 2017

Alternatively, the distribution list can be accessed by clicking on the ‘Distribution’ section
located at the bottom of the open form. As the mouse pointer hovers over this section, it
will highlight in blue to indicate a clickable link.

After you have checked the distribution list, to issue your form; open the form in the editor by
double clicking on it. The form then opens with a toolbar at the top of the screen, as shown
below.

You can also manage your distribution list globally for all Jobs via Tools > Distribution List.

Starting the Issue process

Architects/Contract Administrators Instruction 2 - Draft
JH.@@@ Vi |4 EBa@ B U

=

Clicking on the
distribution list.

icon then starts the process of issuing your form to those on the
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Locked fields

Upon issuing the form for the first time in a job, certain fields will be locked down, and the
user will not be able to edit them - a warning is given as illustrated below:

NBS Contract Administrator

Issuing a form will automatically save all your changes.
lssued forms can be changed back to draft status using Recall Last

Issued Form.
Please note, this is only available for the last issued form on each job.

Issuing a Contract Administration Form will lock the fellowing fields in
the job details editor:

- Employer

- Contractor

- Form of contract

- Job reference

- Currency

- Contract sum

- Full retention percentage

- Half retention percentage

Do you want to continue?

By doing this, NBS Contract Administrator is ensuring that the addresses used on issued
forms remain consistent (i.e. you cannot change who the employeris). Also, if you had issued
a form, or performed a calculation within NBS Contract Administrator then went to edit the
Contract Sum on the job details form, it would result in any subsequent forms being based on

incorrect information.

Click Yes to confirm and continue.

Reason for Issue

If desired, the user can provide an explanation as to why the forms were issued i.e. 'Architect’'s
Instruction for amendments to first floor external opening’, or a message to pass on to the
reader, indicating what you require them to do with the forms you have issued to them. You
can select from a list of Issue reasons, or enter your own. If you wish, you can suppress the
message from ever appearing again by checking the box next to ‘Don’t show this message
again’. This can be reactivated by accessing Tools > Options > Display.

o NBS Contract Administrator “

Please enter an issue reason.
E.g. For Payment, For Construction, Fer Infermation.

This information will be included on the accompanying
transmittal sheet.

oine] v

|:| Don't show this message again

Any text entered here will be displayed on the bottom of your transmittal sheet. You can

choose to leave this blank, just click OK to continue.
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NBS Contract Administrator will automatically convert your forms into a PDF format. You
will then be asked if you wish to open your forms for viewing. If you wish to do this, your
forms will be opened by your default PDF-compatible software, for example Adobe Reader.

@ Please note:

Although you can still open forms which have been issued from the active job,
you will not be able to edit them. The Issue, Save, Save and Close buttons will

be disabled.

This prevents users from editing forms that have already been issued, and so

causing any confusion as to what was issued, when and why.

Form status

When there are no forms open, the form list is shown. From here the user can see what forms
have been used in conjunction with the job so far and the status of them:

Form Title Mumber Status Date created
ArchitectsfContract Administrators I... 2 = 22092017
Architects/Contract Administrators I... 1 22092017
Architects/Contract Administrators I... 3 12/10/2017

The orange square indicates that Form number two is in draft status. The white triangle
shows that the form has been issued but is still capable of being recalled and the grey circle
indicates the form has been issued but can no longer be recalled.

Any form can be opened for viewing by double-clicking, and any form can be printed.
However, only forms that are in draft status can be edited.




Working with

forms

Recalling an issued form

Occasionally you may need to recall a form that you have issued - for example an incorrect
date may have been entered to an extension of time certificate, or there may be a misspelling

on an instruction form.

NBS Contract administrator allows you to recall the last issued form, allowing you to alter
text, figures and spelling mistakes. This allows you increased flexibility when issuing forms.

If anissued form can be recalled, then a button will be displayed at the top of the form window.

Architects/Contract Administrators Instruction 3 - Issued

& 2 e2(a) B 7 U

Click the 4 button to begin the recall process.

Amendments can then be made as required; the benefit of this is that the majority of work for
that Architects Instruction Form will not have to be re-done from the very beginning. Click on
the Issue Form button to reissue the form.

@ Please note:

You can only recall the last issued form within a job.

You will also need to delete any PDF documents which were created when you
issued the original version of the form. By not deleting these forms, it may lead

to confusion if there are (at first glance) multiple copies of the same form.
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Exercises

Exercise One

Using the job you created in Section Three, do the following:

e Add an Architects Instruction Form.

¢ Inthe draft Al Form, complete the first item as follows:

O

O

O

@)

Title: ‘New Concrete Sills to Bays’

Details: '‘Replace 3 no. cracked Bath Stone Sills to windows bays to
ground floor main elevation Use 3 no. precast concrete sills of
dimensions to match existing stonework.’

Omit: Column is left blank

Add: £250 entered.

e Specify a second item:

©)

@)

O

O

Title: 'Fire Compartmentation in roof space’

Details: ‘Provide 2 no. of one-hour fire resistant partitions in roofspace
over the original party wall positions comprising a stud framework and 2
no. layers 12.5mm Wonderboard screwed to each side and sealed in
accordance with the manufacturer’'s recommendations.

Omit: Column is left blank

Add: £500 entered.

e |Issue the form, ensuring that the pricing information has been included.

Locate the PDF forms produced, and check they are correct.

Check the status of the form - is it an orange square?

Open your job details - has the contract sum updated correctly?
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forms

Exercise Two

e From the forms list, add a second Architects Instruction form, this time using a
different method of adding.
e Complete the item editor, as follows:
o Title: Extract Fan WC 2
o Details: Supply and fix 1 no. ‘Loovent’ as per specification ref. N10_30 to
wall of first floor WC_2 ducted to the outside through adjoining roof using
roof cowl accessories.
o Omit: Column is left blank
o Add: Enter £500
o Ensure that pricing information is not included in the issued copy.

e Close the form ensuring that your changes are saved.

Exercise Three

e Re-open the form from Exercise One.

e Were you able to re-issue the form? If not, why could this be?

e Re-call the form, repeat the steps outlined on the previous page, and then re-issue
the form.

e Go back to the forms list and ensure that all forms are showing a status of ‘issued’.

Exercise Four

e Create a new type of role named ‘Landscape Architect'.

e Open the address book and locate Goode Building we created earlier, add a new
team member called ‘Stephen Irwin’.

e Give this team member a role of ‘Landscape Architect’.

e Set the distribution list to include this new member and ensure they receive two
copies of all forms issued.
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Section 5: Managing your jobs

Upon completion of this section you will be able to:

4

Have a clear understanding of the different types of job category within NBS
Contract Administrator.

Be able to re-order your jobs according to differing criteria.
Be able to change the status of your jobs.

Be able to delete a job that is no longer required.



Managing your

jobs

Managing your jobs

As explained earlier, there are three different categories of job:

e 'Jobs' - which details jobs that are currently active within your company.

e 'Demo’ - which shows examples of jobs that have been created by NBS to illustrate
the different forms of contract and associated forms that can be used within them.
These jobs enable users to become familiar with the software without affecting any
real, current jobs.

e 'Archive’ - this provides a location to store jobs that are either completed, or which
are currently no longer on-going, but may become active again sometime in the future.

Once the user has selected which category of job to view, all jobs within that category will be
displayed in the central window.

Double-clicking on the job title will then display the titles of all forms used in that job so far in
the centre of the screen. In turn, double-clicking on a form title will open that form.

Sorting your jobs

As more jobs are added to NBS Contract Administrator, you can personalise the way that
they are ordered to make it easier to find your jobs.

Your list of jobs can be sorted in four ways, by most recently edited, by job reference, by
contract type or by job title.

To change the il |

sort order, Ref. Title Date modified Form of contract

simply click on IBA_06_10 Badminton Courts 19/07/2017 10:07 ICD 05

the relevant 1A 04 4 Language Laboratories 19/07/2017 10:07 IFC 98

column title: IBA_04_20 Fairbridge School Library 19/07/2017 10:07 1CT 98
IBA_D6_05 (Carling Academy Extension 19/07/2017 10:07 MW 05
IBA_D4_16 Marine Buildings Renovation 19/07/2017 10:07  Mw 98

IBA_05_15 Centre For Sustainability 18/07/2017 10:07  SBC 05
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Archiving your jobs

When you have finished working on a job, you may store it in an archive area in NBS
Contract Administrator - this will mean that your job explorer is a more manageable size.

To archive a job, select the job in the job explorer. Go to File > Move [job] To > Archived
Jobs.

Cec] Forr
File | Wiew Job Tools Help

Mew job Architects/Contract A
Mew Job In Progress... = @ A =
Open The Fox And Hounds Né-
Close The Fox And Hounds 1Tt
Delete The Fox And Hounds
Works: Ful

‘ Move The Fox Aind Hounds To 3 | Real lobs i 10
Ou

Exit Demo Jobs Co

E Forms (3) | Archived Jobs

[& Architects/Contract Administrators Instr...

o )
1= Cost tracking Under the terms of the I

Accessing archived jobs

To access an archived job, go to View > Archive. The job explorer will change to show your
archived jobs.

If a job is moved to the archive, it can still be opened, with forms edited and issued as per

normal.

File | View | Job Tools Help
Jobs Mavigator Pane Jobs
E‘i 2l Guidance Pane > |ler o :
_“;_ cr Search MBS Guidance  » Ref.
n_-? Cr lobs abc123
Demos StampEx ...
Archive 025mka
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Moving an archived job back to Jobs view

To move a job from archived jobs, back to the Jobs view, select the job in the job explorer. Go
to File > Move [job] to > Real jobs. The job can then be accessed under the Jobs view, within
the job explorer.

By organising your jobs into the ‘archive’ or ‘job’ view, it will help keep your current jobs clean
and ordered. At a glance, users can see which projects are currently on hold, have been
completed, or are currently on-going.

Deleting your jobs

NBS Contract Administrator allows you to delete your jobs; this should be considered
carefully as this cannot be undone at a later time.

Please note that if you delete a job, your associated exported PDF forms will not

be deleted and will remain in the output location specified in the job details.
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To delete a job, click on the job in the job explorer and go to File > Delete job. You will be
asked to confirm that you are sure, click OK to continue or Cancel.

] NBS Contract Administrator

Warning
! 5 Deleting Mew Pub, will also delete all its associated draft and issued forms. Once deleted, vou will MOT be able to retrieve this
information. PDFs of issued forms will not be deleted.

Are you sure you want to delete New Pub?
t_)} More about deleting jobs

| oK | | Cancel

Alternatively, from the job explorer, users can also right-click on the name of the job, and
select '‘Delete’.
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Exercise

1. Change your view in NBS Contract Administrator to display Demo Jobs.
With the list of jobs open, sort the list into alphabetical order.
Open the ‘Centre for Sustainability’ then archive it.

Change your view in NBS Contract Administrator to display only Archived Jobs.

s W N

Locate the Centre for Sustainability job, and move it back to Demo Jobs.
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Section 6: Printing forms, exporting forms
and creating reports

Upon completion of this section you will be able to:

v Export forms you have created.
v Print a copy of your forms to retain for use in the office.
v" Work with accurate financial reports produced by NBS Contract Administrator.




Printing forms, exporting

forms & creating reports

Previewing, printing and exporting your forms

There are a number of ways to view a print preview and print your forms.
You can:

e Click on 'Forms’ in the job details panel, then right-click on the form you wish to
print/preview from within the central pane;

4] Forms - StampEx Refurb Stamp exchange refurbishment - NBS Contract Admin
File View Job Tools Help
Jobs Forms - StampEx Refurb Stamp exchange refurbishment
Bl Aljobs 2-& 3
f‘i Create a new job Form Title Mumber Status Date created
°_-1"- Create new job in progress Architects(/Contract Administrators I... 1 09/10/2017

StampEx Refurb Stamp exchange refurbishmen Interim Certificate 1 03/10/2017

] Architects/Contract Administrator - . - -
M Job Details Adiustment of Completion Date Open 2. Architects/Contract Administrators Instruction
88 Team Non-Campletion Recall Last Issued Form
E Erms ) Practical Completion Delete
Architects/Contract Administrators Instr... . .
st aasteaia () Interim Certificate Print Preview 2. Architects/Contract Administrators Instruction
; Certificate of Making Good T -
[E] Non-Completion Final Certificate 1 09/10/2017

(= Pracucal Complenon (1)

E Certificate of Making Good (1)

E Final Certificate (1)

2 adjustment of Completion Date (1)
1~ Cost tracking

e Oropenthe form and click on the Print Preview button =+ located in the top toolbar;

a-i

Forms - StampEx Refurb Stamp exchange refurbishment
‘ [+)

e Finally you can click on the form you want to print preview or export in the list of forms
associated with your job, then click on the ‘Job’ drop down menu, and select
accordingly.

L] Forms - StampEx Refurb Stamp exchange refurbishment
File  View | Job | Tools Help
Jobs Add Form e Emp exchange refurbishment
Floal jobs Open 2. Architects/Contract Administrators Instruction
*% Createans S mber Status Date created
_‘1.‘. Create ney Recall Last [ssued Form 03/10/2017
[ ——— Delete 2, Architects/Contract Adrministrators Instruction 09/10/2017
mpl uf
b 10b Details Add Team Member 09/10/2017
& 09/10/2017
E Team © | Print Preview 2. Architects/Contract Administrators Instruction 09/10/2017
Forms (9
. . . 09/10/2017
E Architec Edit Instruction ltems Cost Tracking 09/10/2017
B :telm Job Cost Tracking Report 09/10/2017
lon-Cor|
B Practica Job Instructions Report 05/10/2017
B certifica Job Activity Report
& Final ce Job Valuation and Certificates Report
= B Adju:]““ Job Financial Statement
Cost tracking

Your form will open in a new print preview window. From here, you can print or export the
form by clicking on the relevant buttons.
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Printing a form

To print the form, click on the Print button.

] Print Preview
=] | g Print.. | D | 34 | OB = | a ® v W [ A |@§E:kx‘.'§r: @) Forward |

Exporting a form

There will be times when you need to share information that you have produced using NBS
Contract Administrator with others who do not have the software and therefore cannot read
the files in their native format.

Fortunately NBS Contract Administrator makes it very easy for you to export information to
PDF which can be opened in Adobe Acrobat Reader.

To export the form, click on the Export button.

o Print Preview

& | i2a Print.. | Il | & | OB s | e ® hd | N [ 1 |(’aﬁ5:ka‘.'arc @E:-r.‘.'ar: |

You will be asked to specify a location for the exported report (PDF format) to be created, click

Save when you have browsed to the desired location.

@ Please note that printing or exporting a draft form does not change its status to
‘issued’. The only way to change the state of a form to ‘Issued’ is by issuing the

form, as described in section four of this guide.




Reporting on your job

Printing forms, exporting

forms & creating reports

NBS Contract Administrator can generate reports on the financial position and contract

communications for each job. The reports for the active job are generated by selecting a

report title from the Job menu.

Forms - StampEx Refurb Stamp exchange r¢

File  View | Job | Tools Help
Jobs Add Form v Emp exchange refurl
B All jobs Open 2. Architects/Contract Administrators Instruction
2% createans Close Form mber Status Dab
% Creats new Recall Last Issued Form | > 09/1
e — Delete 2. Architects/Contract Administrators Instruction 09/1
mp 1
) 08f1
M Job Details Add Team Member o)1
Qt__ Team Print Preview 2. Architects/Contract Administrators Instruction 09/1
B Forms (@) 03/1
E Architec Edit Instruction lterns Cost Tracking 09/1
E Interim lob Cost Tracking Report 09/1
Mon-Cor . 09/1
& Practica Job Instructions Report
=] Certiﬁca| lob Activity Report
[ Final Ce lob Valuation and Certificates Report
1 E Adjustm Job Financial Statement
77 Cost trackirg

The options are:
Edit Instruction Items Cost Tracking

Before you print the Job Cost Tracking Report, you will need to edit the figures to reflect the
claimed and final agreed figures. Each column will need a figure in it otherwise it will show as
TBA (To Be Agreed) on the Job Cost Tracking report.

[+ ] Instruction ltems Cost Tracking “
Use the table below to manage cost tracking for all yvour Contract Administrators/Architects Instructions’ tems on job: Centre For Sustainability.
@ More about instruction items cost tracking
Form title | Status = Mumber| Created date =
El- ArchitectsiGontract Administrators... [ 4 23 January 2017
Omit Add
Numher\Title | Type |Das[:r|ptmn | Estimated |Claimed |Agreed | Estimated |Claimed |Agreed
1 External services INCOMING GAS MAIN Accept the. 400.00 500.00 450.00 248 DD 400.00
-_ (a) HIP TILES OMIT: Farland |__372.000 _400.00] _400.00] _514.00]
Superstructure (b} HIP 1RO 0. DD 0.00 0.00 0. DD . 0.
403 Internal finishes  FICTURE-HA 0.00 0.00 0.00 50.00 200.00 80
0 Superstructure ELUX R 0.00 0.00 0.00 0.00 o.00 0.
Substructure MORTAR 0.00 0.00 0.00 0.00 0.00 0.
Substructure REDUCED LI 0.00 0.00 0.00 0.00 0.00 0.
El- ArchitectsiContract Administrators. .. (] 3 23 January 2017 o
Omit Add
MNumber | Title | Type | Description | Estimated |Claimed |Agreed |Estimated |Claimed |Agreed
301 Miscellaneous Dema instruction number 3, item 0.00 100.00
I'ﬂ Architects/Contract Administrators. . 8] 2 23 January 2017 =
< | D
Job Cost Tracking Report oK ‘ | Cancel | | Apphy |
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Job Cost Tracking Report

This report gives a breakdown of all draft and issued Architects Instructions within a job. It
gives a summary of all individual items within the job and the overall estimated, claimed and

agreed costs.

12 October 2017 10:524M XYZARCHITECTSLTD Page: 2 o 4
JOBINSTRUCTIONITEMS COST TRACKING REPORT

Job reference: IBA_18_15 Diate of possession: 18 December2016
Centre For Sustainability
Fairbridge University Original date for compietion: 22 September 2017
Elway Road w L
Neweastle-Upon-Tyne Revised date forcompletion: 23 October 2017
Contract r £613,750.00
Contractor: Meville Canstrucion Lid ontractsum
S6High Stredt
Mewcastle-Upon-Tyne
Tyneand Wear
Instruction Item Cost
Number Date Number Type /Title / Description Estimated Clzimed Agreed
4 Diraft Architects/Contract Administrators insfucion
4.01 External semvices -182.00 -100.00 tha

INCOMING GAS MAIN Accept the quotation ref.no.
8438 63 dated 6 August 1989 received from EuroGas
in the sum of £248.00 for the new incoming gas main
and supply and installation of gas meter. Acopy of
their quotation is attached. This sum is to be set
against the provisional sum of £400 included under
ref.3_2G in the bill of quantities.

4.02 Superstructure 142.00 tha tha

{a) HIP TILES OMIT: Farland concrete third round hip
tiles, bill of quantities ref.5_15E. ADD in lieu: 4 no.
Red Bank 300mm long red Terracotta third round

segmental ridge tiles. list no.259

Superstructure 0.00 0.00 0.00

{b) HIP IROMS OMIT: 4 no. hip irons, bill of quantities
ref.5_15F. ADD in lieu: 4 no. Red Bank 300mm long
red Terracotta Scroll hip finial tiles 225mm diameter.
Hip tiles and finial tiles to be obtained from Farbridge
Bank Manufacturing Co. Ltd.

403 Internal finishes 80.00 200.00 80.00

PICTURE-HANGING FACILITIES IN ACTIVITIES

ROOM Supply and fix aluminium picture rail approx.
12m lona and 100 no. tvpe (b} U-shaped hooks

All reports can be exported to either .pdf or .xls file types. This means the .xls file can be
opened in Excel as a spreadsheet.

Job Instruction Report

This report gives a summary of all issued Architects (or Contract Administrator) Instructions
within a job and their estimated impact on the contract sum. A summary of draft Architects

Instructions is presented in a separate table.




Printing forms, exporting
forms & creating reports

Job Activity Report

This report gives a chronological summary of all issued contract administration forms on a
job, with a summary of draft contract administration forms presented in a separate table. It
shows the commitments made (the estimated adjustments to the contract sum as detailed
on issued instructions) and the amount of money certified on payment certificates, and uses
both to keep a running total of the amount still outstanding on the contract.

Job Valuation and Certificates Report

This report deals with monies defined in a job. It lists all the payment certificates, detailing the
current amount retained by the employer and the outstanding contract value. Draft forms are
not included in this report.

Job Financial Statement Report

This report shows the financial effect of all issued instructions, grouped by instruction type.
It also details all of the payments made, as well as the outstanding contract amount. Towards
the end of the report is a list of nominated sub-contractors applicable to the job. Financial
information on draft forms is not included on this report.

Elaget O/ D@ e a@ vlm @ [ | @eschvard @ Eorverd | ) Export..

L o3 g DB

o
~

Jobreference:  |BA_16_15 Formofcontract SBC 16

Dateof possession. 18 December 2015
Original date for completion. 22 September 2017
Revised dste forcompietion. 23 October 2017

‘Centre For Sustainabiity

Fairbridge Universiy
Elway Road
Newcastle-Upon-Tyne

Contractor Meville Construction Lid
- 66 High Street
- Mewcastle-Upon Tyne
N Tyneand Wear
H
B Contract sum
- Totaladvance payment
4
- instructions: - Omit Add et
N PC sums 0.00 200.00 200.00
- Miscellaneous 0.00 100.00 100.00
s
- Totais of adjustment 0.00 300.00 300.00

Contractsumas sdjusted by finsl certificats:

Payments certifisd -

- Cumuiative Amount  Certified to
s Issue date GCert number Ssrisinumber  reimbursemen certifea date Retention
Interin
23January2017 1 100000 6358632 6358632 339928
N 23Janvary 2017 2 200000 6699560 13058200 6,976.00
- 23January 2017 3 3,000.00 759999 138181.99 743083
2 23January 2017 4 400000 2677551 16485750 8,892.50
- 23January 2017 5 500000  28117.50 19307500  10,425.00
23January 2017 6§ 500000 5563200 24870700 1335300
- 23Janvary 2017 7 - 500000  57.97565 30666265  16404.3%

Outstanding contract vaiue

LT

<END OF REFORT »
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Exercise

Exercise One

Open the first architect’s instruction form that you created as part of exercise four.
Once the form is open, export a copy of the form to PDF format, and ensure it is

exported to the Windows Desktop.
Exercise Two

Change the view from ‘Real’ jobs to ‘Demo’ jobs, then select the job entitled ‘Language

Laboratories’:

e  Which report could you run to view how many Instruction forms have been
issued?

¢ What was the original contract sum for the Language Laboratories job?

e What is the total adjusted contract sum as a result of all the instructions issued?

¢  Which report would be used to determine any outstanding contract value?

e For the Language Laboratories job, what is the outstanding contract value?




Office and user settings

Section 7: Office and User Settings

Upon completion of this section you will be able to:

v" Customise the way in which NBS Contract Administrator functions in order to
suit your own preferences.
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Defining your office settings

There are a number of options available within NBS Contract Administrator that can be used
to customise system settings.

= Forms - IB
File View lob |Tools [Help
Demos Spell Check... ns-IBA_16_15 Centi
5T Spell Check Options...
Fl Al demos P P @ _~:.>
_° ¢ Create a new dem ‘ Options... |I'|ﬂe
ax )
#: Create new demo i Address Book... cts/Contract Administrators I...
riificate
IBA_16_15 Centre Fo| istributi i
. DEtributionllLy Cts/Contract Administrators I...
IE Job Details Instruction Types... Cis/Contract Administrators L...
% Team Roles... Cts/Contract Administrators I...
+  Sectional Completig a1 Detail Certificate
B Forms (32) it lssuer Uetails... Ent of Retention
B Architects/Conty Licence Status... ent of Reimbursement
& Interim Certifica Certificate
& statement of Re Check For Updates ent of Retention
B statement of Reimbursemen Statement of Reimbursement
& Partial Posse.sslon by the Employer (1) Interim Certificate
E] Non-Compition (1) Statement of Retention
B Prac.tlcal CD"“F"E‘]?” (0 Statement of Reimbursement
B certificate of Making Good (1) Interim Certificate

The options menu is divided into four different tabs as shown overleaf. Selecting each tab
displays the relevant options available. Selecting one of these tabs then displays the options
below, relevant to that tab.
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Setup tab

The setup tab is divided into two sections:
Serial Number Prefix

All payment forms created in NBS Contract Administrator are given an automatically
generated serial number when they are issued. This facility could be used to distinguish

between forms issued by different branches of your office and can be a combination of up to
4 letters and numbers.

The prefix of serial number is determined by what you enter here.

b Options ﬂ

Setup || Form logo ||FiIeLucatiuns|| Display |

Serial Number Prefix:

This prefix can be used to uniquely identify that a form eriginated in your office, or to
distinguish between forms issued froem branch offices if applicable.

SHNUM

rial number prefix

General Options:

The following options define how certain information is displayed by default in NBS Contract
Administrator.

Defautt currency | £ Pounds v

Clear all 'Tron't show me again’ selections made to date: Clear all

General Options

Currency - This section allows the user to set up a default form of currency to be displayed
on any forms generated within NBS Contract Administrator.

Restore help pop up information - A number of information boxes within the software
display helpful information to the user. These help boxes can be switched off if desired. In

order to set these help boxes to reappear, the user can click on Clear all.
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Form Logo Tab

This tab allows the user to show either the RIBA crest on forms generated within NBS
Contract Administrator, to not show any type of logo, or to use a custom logo such as your
own company's logo.

b Options “
Setup Form logo || File Locations || Display |

By default, NBS Contract Administrator will dizplay the RIBA crest logo in the bottom left
corner of your forms. You can alzo gelect to not display a logo, or show your own custom
logo by browsing to its location uging the option below.

t_an Iore about displaying a custom logo on forms

Display Options:

(s} Display the RIBA crest (default)
(O Do not dizplay a logo

() Display a custom logo:

L]

Clicking on the browse button ] enables the user to select the logo they wish to use.

File Locations Tab

When NBS Contract Administrator is opened for the first time, you will be given the option
to create a new data store to contain all your job information, or to browse to an already
existing data store. If at a later date you need to change your data store, this can be done
from this tab.

Once you have selected your desired data store select the OK button and the data store will
be recorded in NBS Contract Administrator.

Default Output Directory

The output location is a directory where all of your PDFs (issued forms) will be created. Once
you have selected your desired directory, click the OK button and the default output directory
will be changed for all future jobs created in NBS Contract Administrator.

Clicking either browse button allows the user to select an appropriate location.
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Setup || Form logo || File Locations || Display |

To change a file location, select the browse button and navigate to the desired location on
your network or local machine.

-@ More about the data store location

@ More about the default output directory

Data store location: |C:1User5\ﬂetch ek\Desktop\CAFtab. cadb I:l

Default output directory: |C:1User5.1ﬂetch ek\Desktop\Outputh

Display Tab
This option allows the user to show or hide the status display bar. The display bar is shown
in the bottom right hand corner of the NBS Contract Administrator software.

Setup || Form logo || File Locations || Dizplay |

W  Display Status Bar?

The status display bar shows your update status and your licence details.
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ou are up to date ~ | Your subscription will expire on 28 February 20138

The status bar also indicates if there are any updates available for NBS Contract
Administrator. If there are updates available, the user can then download the update file and
apply this to their version of NBS Contract Administrator.

NBS Contract Administrator can receive content updates periodically via the NBS website.
These updates can include updates to the software itself, as well as updates to the content
within - such as new guidance notes, or new forms of contract.
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Appendices

. Appendix 1 - Types of entry within NBS Contract Administrator

. Appendix 2 - Types of form supported in NBS Contract Administrator
. Appendix 3 - Working with Payment forms

. Appendix 4 - Administration Tools

. Appendix 5 - LAN Settings and Software system requirements
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Appendix 1 - Types of entry within NBS Contract
Administrator
Completing Forms

Many of the forms within NBS Contract Administrator require certain information to be

completed, before they can be issued.

These fields typically require text to be inserted (in an instruction form for example) or a date
to be specified. Below is a description of these fields, and how they can be completed.

Calendar fields

Some selection fields are for selecting dates, when you click on them a calendar will appear.

T AL L

COMPLETION C

Motification of

Adjustment of

. MNoti f del
Completion Date N

The Contractor must

Contract Administrate
progress is being or
listing out the materiz

Jobreference:  IBA_16_15

Motification no: 3

12 October 2017 | [ | < >0 0%
1 October 2017 * DJUSTMENT ¢
Mon Tue Wed Thu Fri  3at Sun DMPLETION L
25 26 27 28 29 30 1
2 3 4 5 4] ) ] ]
lecember 2016 9 10 11 13 14 15 [Dtract details
1 17 18 19 20 21 22
23 24 25 26 27 28 29 |ptract details are ¢
I N 1 2 3 4 5 ; ;
eferencing the inf
[ Today: 12/10/2017 .

et | 0D Details. Plea

anly be made within t
are no forms created

To select a date that is shown in the displayed month, click on the required date. If you require

a date from a different month, use the arrows ' ' to move the calendar to the selected
month, from there you can click on the desired date. Alternatively click on the name of the
month, this will then display a drop down list from which the user can select the month they

require.
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Linked fields

Some fields are populated by information that is entered elsewhere. For example, the
retention field in an interim certificate is populated from the retention statement. These
fields, which are populated by ‘external information’, are shown with a button. Clicking on the
button will take you to the appropriate information entry point.

This interim certificate of progress payment is issued under the terms of the

MWW Building Contract dated 03 January 2017

Value of work executed and of materials and goods on site ...
(calculation attached)

Amount payable [ 97.5 % ofthe above value).__........._...._.... £ 975.00
Less total amounts previously certified ... £ 56,905.00

Radio buttons

Radio buttons allow a user to select only one option from a series of choices. When you select
an item, the other choices are deselected. Deselected items will be struck through in both
print preview and exported PDF format.

Under the terms of the SBC Building Contract dated 12 December 2016

IWVe hereby certify that the Contractor has failed to complete

® the Works
) Section no. - ofthe Works

by the relevant Completion Date, namely
23 October 2017

Click on a radio button to select the appropriate value.

Editable boxes

Underthe terms ofthe SBC  Building Contract dated 12 December 2016
liwe hereby state that a part of the Works, namely

was taken into possession by the Emplayer

on E~

Many forms come with static text the user cannot edit. However, there will be some areas
where the user is required to enter details specific to the job. Such areas are shown as
indicated below.

Fully editable fields are shown as white boxes. To enter information, click into the box and
complete as required
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Spell check options

You can change the options using the spell check options tool.

Spell Checking Options u
Options | |User Dictionary Contents | Common Misspellings
Check spelling as you type
Ignore words in UPPERCASE
[ lgnore words in Mixedcase
lgnore words with numbers
lgnore Intemst and file addresses
Language:
English (U.K} v
Gares

The spell checker will work through your document and
dictionary. Once a word is found, you have the option to:

locate words not found in the

o Ignore - This will disregard the word.

. Ignore All - This will disregard the word for the remainder of the document.

o Add - This will include the word into your dictionary.

o Change - This will replace the word with the highlighted suggestion.

o Change All - This will replace all words spelt this way with the highlighted
suggestion.

o AutoCorrect - This will change the word to the most obvious replacement.

o Options - Click on this button to alter spell check options, e.g. ignore words in
upper case.

Spelling: English (U.K.)

Mot i dictionary:

Accept the quotation

Suggestions:

refing
refund
rena
ravine
ravit

>

revenue

Options... Undo

|ghore

Ignore Al

Add

Change
Change Al

AutoCarrect

Cancel
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Appendix 2 - Types of form supported in NBS Contract
Administrator

The following forms are all included within NBS Contract Administrator. The forms available
to you on a job are defined by the Form of Contract selected when setting up the Job Details:

Standard contracts
JCT Standard Building Contract 2005 (SBC)

e Instruction

e Clerk of Works Direction

e Interim Certificate

¢ Statement of Retention

e Statement Of Reimbursement
e Partial Possession by Employer
¢ Non-Completion

e Practical Completion

e Practical Completion NSC works
e Section Completion

e Certificate of Making Good

e Final Certificate

e Revision to Completion Date
JCT Standard Building Contract 2011 (SBC)

e Instruction

e Clerk of Works Direction

e Interim Certificate

e Statement of Retention

e Statement Of Reimbursement
e Partial Possession by Employer
e Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Revision to Completion Date
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JCT Standard Building Contract 2016 (SBC)

Architects/Contract administrators Instructions
Interim Certificate

Statement of Retention

Statement Of Reimbursement

Partial Possession by Employer
Non-Completion

Practical Completion

Section Completion

Certificate of Making Good

Final Certificate

Adjustment of Completion Date

SBCC Scottish Standard Building Contract 2005 (SBC/SCOT)

Instruction

Clerk of Works Direction
Interim Certificate

Statement of Retention
Statement Of Reimbursement
Partial Possession by Employer
Non-Completion

Practical Completion

Section Completion
Certificate of Making Good
Final Certificate

Revision to Completion Date

SBCC Scottish Standard Building Contract 2011 (SBC/SCOT)

Instructions

Clerk of Works Direction
Interim Certificate

Statement of Retention
Statement Of Reimbursement
Partial Possession by Employer
Non-Completion

Practical Completion

Section Completion
Certificate of Making Good
Final Certificate

Revision to Completion Date
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Design and Build contracts
JCT Design and Build Contract 2005 (DB)

e Instruction

¢ Non-Completion

e Practical Completion

e Section Completion

¢ Notice of Completion of Making Good
e Final Statement

e Interim Payments Notice

e Revision to Completion Date Section

JCT Design and Build Contract 2011 (DB)

e Instruction

¢ Non-Completion

e Practical Completion

e Section Completion

e Notice of Completion of Making Good
e Final Statement

e Interim Payments Notice

e Revision to Completion Date Section

JCT Design and Build Contract 2016 (DB)

e Instruction

e Interim Payments Notice

e Statement of Retention

e Statement of Reimbursement

¢ Non-Completion

e Practical Completion

e Section Completion

¢ Notice of Completion of Making Good
e Final Statement

e Adjustment of Completion Date
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Intermediate contracts
Intermediate Building Contract 2005 (IC)

e Instructions

e Interim Certificate

e Record of Reimbursement

e Partial Possession By Employer
¢ Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Extension of Time

Intermediate Building Contract 2011 (IC)

e Instructions

e Interim Certificate

e Record of Reimbursement

e Partial Possession By Employer
¢ Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Extension of Time

Intermediate Building Contract 2016 (IC)

e Architects/Contract Administrators Instruction
e Interim Certificate

e Statement of Reimbursement

e Partial Possession By Employer

¢ Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Date
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Intermediate Building Contract with Contractor's Design 2011 (ICD)

e Instruction

e Interim Certificate

e Record of Reimbursement

e Partial Possession By Employer
¢ Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Extension of Time

Intermediate Building Contract with Contractor's Design 2016 (ICD)

e Architects/Contract Administrators Instruction
e Interim Certificate

e Statement of Reimbursement

e Partial Possession By Employer

¢ Non-Completion

e Practical Completion

e Section Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Date




NBS Create Training Guide

Minor Works Building Contract 2005 (MW)

e Instruction

e Progress Payment

e Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
Minor Works Building Contract 2011 (MW)

e Instruction

e Interim Certificate

¢ Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
Minor Works Building Contract 2016 (MW)

e Architects/Contract Administrators Instruction
e Interim Certificate

¢ Non-Completion

e Practical Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Date

Minor Works Building Contract with Contractor's Design 2005 (MWD)

e Instruction

e Progress Payment

e Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
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Minor Works Building Contract with Contractor's Design 2011 (MWD)

e Instruction

e Interim Certificate

e Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
Minor Works Building Contract with Contractor's Design 2016 (MWD)

e Architects/Contract Administrators Instruction
e Interim Certificate

e Non-Completion

e Practical Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Time

SBCC Scottish Minor Works Building Contract 2005 (MW/SCOT)

e Instruction

e Progress Payment

¢ Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
SBCC Scottish Minor Works Building Contract 2011 (MW/SCOT)

e Instruction

e Interim Certificate

e Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time
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SBCC Scottish Minor Works Building Contract 2016 (MW/SCOT)

e Architects/Contract Administrators Instruction
e Interim Certificate

e Non-Completion

e Practical Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Date

SBCC Scottish Minor Works Building Contract with Contractor's Design 2005
(MWD/SCOT)

e Instruction

e Progress Payment

¢ Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time

SBCC Scottish Minor Works Building Contract with Contractor's Design 2011
(MWD/SCOT)

e Instruction

e Interim Certificate

e Non-Completion

e Practical Completion

e Certificate of Making Good
e Final Certificate

e Extension of Time

SBCC Scottish Minor Works Building Contract with Contractor's Design 2016
(MWD/SCOT)

e Architects/Contract Administrators Instruction
e Interim Certificate

¢ Non-Completion

e Practical Completion

e Certificate of Making Good

e Final Certificate

e Adjustment of Completion Date




OTHER

Instruction
Stage Payment Certificate
Statement of Deductions

Completion Certificate
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Appendix 3 - Working with Payment forms

All payment forms have been designed to auto-calculate values where possible. Where

appropriate, payment forms are dealt with as “packages” and can only be added and issued

as such. This is because they have such a strong relationship - fields in one form populate

fields in the other.

@ Please note that record/statement of reimbursements can only added alongside

an interim payment and an interim certificate, if an advance payment is recorded

in the job details.

Retention Amounts

The retention amount is calculated using the retention percentage specified in the job

details. All retention amounts are calculated using the Full retention percentage, until a

certificate of practical completion is issued; all retention amounts will then be calculated

using the Retention post practical completion percentage.

NBS Contract Administrator allows you to overwrite the auto-calculated retention amount

in a statement of retention, progress payments and in interim payments. For example;in a

statement of retention click on the Amount of Retention button. The edit amount window

will appear, to specify a different amount, i.e. to round-up to the nearest pound, click on the

Enter amount manually radio button and then enter the new amount in the box.

Amount subject to:

Gross i - Amount of
valuation Full retention | Half retention Nil retention retention
328,087.0 et 0.00 0.00 16,404 35
| 0.0 || 0.00 0.00 0.00 0.00 |




Appendices

Appendix 4 - Administration Tools

Some tools are not held within NBS Contract Administrator, this is to allow problems to be
resolved without the need to open the software. They are accessible from the Windows
start menu, going to Start > All Programs > NBS > NBS Tools > NBS Contract
Administrator Tools.

Alternatively in your search bar in the Windows menu, search from NBS Contract

Administrator Tools.

Remove Locks

p MBS Contract Administrator Tools ﬂ

Remove Locks Compact and Repair Licensing LAN Sethings

This tool &llows unlocking of projects which are left checked out for )
editing as a result of an application crash or something similar. £y

sed within last 10 mins

Browse To data store:
C:Users fletchek Desktop CARab cadb | | |

Record ID Record Type Locked By Machine 1D Time Last Used
2dad47eb-..  Project Fletchek MCL-TRAINE. ..
Data store version: 2.3.0 Refresh List Remave Locks

Exit

While you are working in a job, NBS Contract Administrator will lock that job to stop
anyone from trying to edit that job at the same time. If a problem occurs with your machine,
e.g. a power failure, then this project will not have its lock removed and will therefore remain

un-editable.

If you find that your project is locked, click on the project in the list and then click on the
Remove Locks button.

Compact and repair
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All of your jobs are held within a NBS Contract Administrator database. To ensure that the
database remains a manageable size, you are recommended to regularly carry out the
Compact and Repair process.

Click on the Compact and Repair tab in NBS Contract Administrator Tools.

pe MBS Contract Administrator Tools ﬂ

Remove Locks Compact and Repair Licensing LAN Sethings

This tool allows the compaction of the selected data store, in order to reduce the size of the file
on disk.

Browse To data store:
C:Users fletchelk Desktop CARab cadb | | |

Check this boo if you would like to replace your existing data store with the compacted version,
or leave unchecked if you would like to choose where the compacted version is saved to.

] Replace Original?

Compact and Repair

Exit

If the correct database is not displayed in the Browse to data store box, then click on the
browse button and locate your database, note that this is your CAFtab.cadb file.

Choose whether or not you want to replace your original database with your compacted
database, by selecting the ‘Replace Original?’ check box. Please note that if you do not
select this option, you will be asked to specify a location for your compacted database.

Click on the ‘Compact and Repair’ button. If you haven't specified to ‘Replace original’,
then you will be asked to provide a location for your newly compacted file. Browse to an
appropriate location and click OK.

Licensing

From here, the user can unlock any software licences which may have become locked as a
result of an application crash or fault with the PC. From this tab, the user can also review
license status, upgrade or renew their existing licence.
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Before carrying out any work on the licence for NBS Contract Administrator, it is advised to
contact NBS Software support on 0345 456 9594,

Remove Locks

Compact and Repair

Licensing

To launch the MBS Licence Viewer, click the button below.

LAN Settings

The MBS Licence Viewer tool allows unlocking of licence tokens which are left locked a5 a
result of an application crash or something similar.

You can also review your licence status, and upgrade or renew your licence using this tool.

Launch Licence Viewer

Alternatively, the licence viewer can be accessed within the Contract Administrator

software via ‘Tools > Licence Status’.
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Appendix 5 - LAN Settings and Software system
requirements

P MBS Contract Administrator Tools ﬂ

Remove Locks Compact and Repair Licensing LAN Sethings

Using a proxy server

If vou need to use a proxy server to access external information, select the checkbox and then
complete the reguired information.

@n More gbout using HTTF prowy servers

| Usean HTTF proxy server

Address: Paort:

Authenticahion

{* |ntegrated Windows Suthentication

" Use basic authentication

|Isername: |

FPassword: | Re-enter password: |

| Test Connection

Exit

NBS Contract Administrator can receive content updates periodically via the NBS website.
These updates include updates to the software itself, as well as updates to the content

within - such as new guidance notes, or new forms of contract.

@ If your computer connects to the internet via a proxy server, then it is important
to complete the details within the ‘LAN Settings’ tab of NBS Contract
Administrator to facilitate this functionality within the software. If you are
unsure as to what these settings should be, please contact NBS Software

support on 0345 456 9594,
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